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%
1. CODECANVAS #fiR -1-
1.1, DL A -1-
1.2. RHER -1-
2. flgTiE -2-
3. mETE -4-
3.1. ZmFAE -4-
3.2. %m¥k (BUILD) -5-
3.3. &% (CLEAN) -6-
4. HBER -7-
4.1. AlgRARE -7-
4.2. TCH TARGET -7-
4.3. F2E FLASH -7-
44. BEHFEEF -8-
4.5. BE GDB -8-
4.6. PAINE -9-
4.6.1. k% (RESUME) -9-
4.6.2. i (SUSPEND) -9-
4.6.3. %1 (TERMINATE) -9-
4.6.4. ¥ N\ (STEPINTO) -9-
4.6.5. Bit (STEPOVER) -10-
4.6.6. i%[A] (STEPRETURN) -10-
4.7. WiR -10-
4.7.1. BIEEW AT -10-
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472. JBH. 2R A -11-
4.7.3. MK S -11-
4.8. ARAE -11-
48.1. AFHERME -11-
4.82. % (DISASSEMBLY) 1 & -12-
4.83. ZFE (VARIABLES) 1K -13-
4.84. FikA (EXPRESSION) L& -14-
4.8.5. W1E (MEMORY) LK -14-
4.8.6. Zifi?% (REGISTER) L& -15-
5. ogiE -17-
5.1. 4x%E5% (EDITOR) -17-
5.1.1. 4K -17-
512. 175 _18-
5.13. Hix -18-
5.1.4. ZTHTHRF -19-
5.2. EWLE (PERSPECTIVE) -20-
53. FRUE -20-
53.1. TFENY2% (PROJECT EXPLORER) -20 -
5.3.2. K4 (ouTLINE) FLE -21-
6. TI2RV ##% T B -22-
6.1. BXEW -22-
6.2. fEAHH -22-
7. FLASH -24 -
7.1. FLASH#IEAD -24-
7.2. BHBIERE -24-
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7.3. FLAsHEEERE -24-
7.4, B -25-
7.5. REFRERIE -25-
7.6. RAEBRIE -25-
7.7, SRR -26-
7.8. BRI -26-
8. HihTH -27-
8.1. ELF2BIN -27-
8.2. FEFEMIK -27-
9. M A: INTRINSIC -28-
9.1. EREH -28-
9.1.1. _ BUILTIN_RISCV_ASR64 -28-
9.1.2. _ BUILTIN_RISCV_DMAC -28-
9.1.3. _ BUILTIN_RISCV_FLIP -29-
9.1.4. _ BUILTIN_RISCV_GET MR -29-
9.1.5. _ BUILTIN_RISCV_GET MR -30-
9.1.6. _ BUILTIN_RISCV_LSL64 -30-
9.1.7. _ BUILTIN_RISCV_LSR64 -31-
9.1.8. _ BUILTIN_RISCV_MAX -31-
9.1.9. _ BUILTIN_RISCV_MIN -32-
9.1.10. _ BUILTIN_RISCV_MPYA -32-
9.1.11. _ BUILTIN_RISCV_MPYS -33-
9.1.12. _ BUILTIN_RISCV_QMPYA -33-
9.1.13.  _ BUILTIN_RISCV_QMPYS -34-
9.1.14. _ BUILTIN_RISCV_RESTORE -35-
9.1.15. _ BUILTIN_RISCV_SAVE -35-
9.1.16. _ BUILTIN_RISCV_ROL -36 -
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9.1.17. _ BUILTIN_RISCV_ROR
9.1.18. _ BUILTIN RISCV_SADD
9.1.19. _ BUILTIN_RISCV_SSUB
9.2. BFFHRE

9.2.1. __ BUILTIN_RISCV_FRACF32

-36 -

-37-

-37-

-38-

-38-
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1. CodeCanvas Wik

CodeCanvas 5t HRPAE A E RV RFIALEE S 1) ] 5 5 FH 52 T KA 55 (IDE) .
% IDE #£T- Eclipse™, R HH— AR E R TR, 145095 C/C+H1EF M9
. gmiE AR TR .

CodeCanvas i TR N IR IR S &5 Rk 55 AN E AT A LR e S Al 11 S
IR SCHRFAFE A SR BN 2% SCRE S B0 H A% % 1 TR A 1 e 14 e R %2 55 - CodeCanvas
FNR PSR T 5 T B & TH, flan T HAE . V8% Flash Bk T H. EME IDE
W9 FIF RN AN I R RN IR, AR E T A 3R 15 6 5.

1.1 RBMER

® L, MRLENH

® LT Eclipse MR K IR (IDE)

® iR 5 IS

o HEOMMMARTHE, WfhgmEds. IDWas. ERSAINEEE
® . ARECAL Y itk BE R 2%

® i BIRE, s BT

12. REER

Windows 10 Professional/Enterprise/ 64 {7,
BT %N 2 GHz [ 5 A% AL E 48 B 1K 3.3 GHz I XUZ AR HL 25 .
Fhig#(RAM)Z [ AMET 1 GB, B UCKH 4 GB 7% -

BRI AL (HDD) % 8] MK T 2GB-.
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2. QI T

2

4

AW TR L, — N EIESE —IRIZAT eclipse B, 78 Ac M T2 0 a2 11,
A LU B|“CC Project™ 88 (4l 2-1), ARIT4T AR TR S H— AR A
L “file”, AR)FIEFE “new”. “CC Project”, WK 2-2.

There are no projects in your workspace.
To add a project:

$ CC Project
4 Create a project...
s Import projects...

Kl 2-1 TR

- - -

File Edit Source Refactor Navigate Search Project Run Tools Window Help

New Alt+Shift+N > € CC Project

Open File... N Project...

K 2-2 Bl TR
W 2-3, A AR TIE4, WM, THEES, THERA, ™=

SRJG E i “Finsh”1%4H, IDE % Hsha@En NEE 1 TR, W 4)i% T with demo
TR 2 A2 il A A FH AR SRS

=

New CC Project

Create a new CC Project.

Project name: |[RV335demo

Use default location
C:\MyStuff\Eclipse\runtime-New_configuration' | Browse...
OQutput type: |Executable
Language: C
Owith demo
Tool chain: LLVIM
Device
Family: Spring Core Family
Product: RV335

)
)

K 2-3 gl TR
eV R TR TENYE ER, ik 2-4.
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g m et e -
v 5 = RV335demo [runtime
ki Includes
% = include
& > src

% = system

K 2-4 TR
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3. ik LIE

4

+

CodeCanvas fi ] Make #£47 T2 B, FEGUE THERS, H )42 R makefile ST
1, RN AT SAREIN BOOHER, Make K ESiE, RXT E—X9W
PRI RAE T SISO AT ik, R AR B S AN e, 1998 T R )

3.1. HmiRELE

PR Seih TR, RJE SRR, E$E “Properties”s

AR FESH S R M LR, RIRIESE “C/C++ Build”, “Settings”. {E:
AR “Tool Settings”¥EIi~, P LUM S Bt LSmae. BEHAS ARG B 3T 180K,
A 3-1,

I Properties for RV335demo =R E=E
type filter text Settings (=1 4 - &
> Resource
4 C/C++ Build =
Build Variables Configuration: [DEbUQ [ Active ] '] [Manage Configurations...

Environment
Logging
Settings

 Tool Settings | # Build Steps | | Build Artifact | [u Binary Parsers | @ Error Parsers

4 % RISCV Compiler [¥] Generate debug information (-g)
(2 General compile only (-c)
(2 Additional options
4 1y RISCV Assembler
(% General
(2 Additional options “mabi ilp3zf
‘ @gs(}c:ﬂ:::er include paths (-) [ZR 0= &
(& Additional options

o

3.5

T+
I
o
a
3
3
[ B
m

Run/Debug Settings --target riscv32-unknown-elf

rrrrr h rv32imf_xsc

${FDMTEK IDE HOME) riscvignu-toolcha

${FDMTEK_IDE_HOME}riscvignu-toolchai
${FDMTEK_IDE_HOME}riscv\gnu-toolchainyriscv32-unknown-slfinclude \ +4\12.2.0
${FDMTEK_IDE_HOME}riscvignu-toolchainiriscv32-unknown-elf\includelc+ +112.2.0\riscv32-unkno)
"$(workspace_locy/$(ProjNamel/src/include}”

(?) Apply and Close] [ Cancel

3-1 JmiFitE
ISR A PR AR TP R R S, AL linker HHHTICE . A BEIE R B 1
TFE, WK A7 Properties => C/C++ Build => Settings => RISCV linker => General, ] J
TR E AW, R 32 fioR. fE Library search path "G & i A E I fE B8 12, 1
Libraries /¢ B 5 &4 7, RS HWHE N libxxx.a, RATHLEMN RE xxx,
PeanFRATTELEE B2 libe.a i, 7EX EACEM ZZHMAS c.
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$ Properties for lab12-5CIB_RS485_PC o
type filter text Settings o=
Resource
Builders
~ C/C++ Build Configuration: |Debug [Active ] Manage Configurations...

Build Variables

Environment - = .
® Tool Settings * Build Steps " Build Artifact ki Binary Parsers © Error Parsers

Logging
Settings v ® RISCV Compiler gnu toolchain path |"${FDMTEK_IDE_HOMEJriscvignu-toolchain®
C/C++ General B General . i
. - target riscv32-unknown-el
Project Natures 2 Additional options 9
Project References + ® RISCV Assembler -march rv32imfe_xsc
Run/Debug Setting 5 General -mabi ilp32f
& Additional options " - P i T
« B RISCY linker inker script (-T) $(ProjDirPath)/systemylink_riscv.|d' Browse...
= General [ -nostdlib
¢ Additional options | [ -nostartfiles
Library serach path (-L) a8 8
${FDMTEK IDE HOMEJriscv\gnu-toolchain\riscv32-unknown-elf\lib
Libraries(-) aa @
< > Restore Defaults | Apply

; oy | cance
K 3-2 shASEEEE

3.2. ¥k (build)
IDE 5 “Debug”fl1“Release” A F %1% /7 %, “Debug” /7 4 ) H bR TSR

AN

R, &AM TR RIS FE R IR “Release” 7 248 L) H AR SCHEA S AE &,

PRLEARARAR R AN — 28, 5 T 54 HARSCrh . RIP aT Lo TRAZ S - B il =
IR T

BHATR A ROE, MO, e TR, Rl AR, AR 1E$F“Build
Project”, MBI, 73— MIriERE sl TR & Blir.

File Edit Source Refactor MNavigate Search Project Run Window He

[mi [ B-R-BiBieiag- e~ QO i®s

{5 Project Explorer &2 ES Y 8 — 0O
4% RV
. New 3
> [l Ing|
432 srd Go Into
> & Open in New Window
= Show In Alt+Shift+W >
B Show in Local Terminal 3
> (3 sys
5 Copy Cirl+C
Paste Ctrl+V
®K  Delete Delete
Source »
Move...
Rename... F2
i Import.
4 Export..
Build Project Incremental Build of Selected Projects ]
Clean Project
Refresh F5

&K 3-3 4wk
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TR AT, P DAE TRE N SHE R A B TR N2 14 sinares H 3%, RITH 1] LA
34 B bSO

3.3. X (clean)

T 5B B 2 i g B 2R R BT B AR AR SO E, T DIME VA S ThEE, AU N R AP
Jivk.

SR 7 TREW EAE Pk h B bR LAE, 85 S bR A8, %4 “Clean Project”.

B R ESEEAE, R “Project”, SRS EFE “Clean...”, FIEHRH HIXSTHAEHILE
Hir LR, S5 S N “Clean” %4, TR,
B clean = (2]

Clean discards all build results and states. The next time a build
curs the selected projects will be rebuilt from scratch.

Clean all projects

5 RV335demo

[] Start a build immediately
@) Build the entire workspace

Build only the selected projects

[ Clean l [ Cancel

3-4 JER
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4. YA
FEAE PR TRERT, 0 0k B AR LRE Ce i 1 H ARSI
A =RhENRITTE, N IR .
SRk A LR AR ke B F AR TR, SR s SR A i, AR IRIEFE Debug

As”. “Debug Configurations”.

5RO M THEAE R - BARAME = M, 2R J51E#E“ Debug Configurations™.

=M AR SR TR, %P Debug as => Application with GDB and OpenOCD .

4.1. BIEAREE

LEHG 3R B g R R, &R e<Application with GDB and OpenOCD”, #A
Ja s bR AR, Bk New Configuration”, 7EA4MIVERE TUHE, W LAGHAC & #E47 EH ay
%, WTHE 4-1.

B3 Debug Configurations

Create, manage, and run configurations

Specify and launch an application with GDB and OpenOCD

B AX| BV - |Name: RV335demo Debug| i

type filter text [] Target . | Main| %% Debugger| B+ Startup| i~ Source| ] Common
[ Application with GDE and Opent| | o 2
14 Rv335dema Debug
Java Applet

E:\software2\SpringCore\230830\riscv\openccd\bin\openocd.exe

Kl 4-1 A &

4.2. BCE target

CodeCanvas 2 H sl F H 77 1) openOCD, WA R, H RN R FH BN
%A
KT “Target (processor) “Fl“Board”iIil, Hi# %f M. openOCD i & X R A%
(core) MIELE, “Board”iLIUAHX T HI# 2 | AMAHINCHE -
4.3. BCE Flash

7E R IANC B AL Y On-chip Flash &K T, ALY Flash #ATECE, W FE 4-2.
AR EZESR T ENE
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Z Target | [E] Main |35 Debugger [On-Chip Flash

Clock Configuration

& Startup| % Source| © Common

OSCCLK(MH2): [30

CLKINDIV: 2
PLLCR Value: |10
configure

Flash Program Setting:
O Erase, Program, Verify
O Program, Verify

® Load RAM Only

O Verify Only

Erase Flash

Erase Sectors Selection:
Sector A:(0x670000 - 67ffff)
Sector B:(0x660000 - 66ffff)
Sector C:(0x650000 - 65ffff)
Sector D:(0x640000 - 64ffff)
Sector E:(0x630000 - 63ffff)
Sector F:(0x620000 - 62ffff)
Sector G:(0x610000 - 61ffff)

K 42

4.4, WEHRAEF

£ Main 3&30F, ANFE QU KBS E K05, 2 BN E RN EARR, AR
Jrid e B FEOR I TR L AR SO, AR TA R BT 3hRE . MARIEE,

W 5N 53 mi i Browse ™ A BEATLEFE, U1F ] 4-3.

3 Debug Configurations

Create, manage, and run configurations

FoEX BT~
type filter text
4 @ Application with GDE and OpenC
& RV235demo Debug
Java Applet
Java Application
& Launch Group
 Launch Group (Deprecated)

Remote Java Application

45. EE gdb

7E“Debugger” ik ik

Specify and launch an application with GDB and OpenOCD

Name: RV335demo Debug
[ Target [ [£] Main . %* Debugger | B Startup| £~ Source | ] Commen

Project

?@

RV335demo
C/C++ Application:
Debug\RV335demo.elf

Variables... | [search Project.. ||| Browse.. |

Build (if required) before launching

Build Configuration: | Select At

2

(©) Enable auto build

@ Use workspace settings

4-3 HH

, AL E R ES A JTAG E 2,

o, AR BRAERDRT, K 4-4.

(0 Disable auta build
Configure Workspace Settings...

IR RIRIE A, /B
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MName: RV335demo Debug

[E Target | [El Main k3 Debugger
GDB Setup

B Startup| - Source | ] Common

GDB Command:
Et\software2\SpringCore\230830\riscvignu-toolchain\bin\riscv32-unknown-elf-gdb.exe

Remote Target

Use remote target

ITAG Device: | Generic TCP/IP -

Host name or IP address: localhost

Port number: 3333|

[| Force thread list update on suspend

Kl 4-4 FLE gdb
4.6. AN
4.6.1. k&2 (resume)
VKL AEHLIN core, 1EHAHIE T, WA 4-5 Fos.
I

K 4-5 k5

4.6.2. F## (suspend)

Browse... | | Variables...

B4 THIZ AT ) core £HitE, B 51817, Y resume kL4 iz 1T . W 4-6 FToR

| w[wE]e = = il
Kl 4-6 i
4.6.3. 24 1E (terminate)
LIEFEFIEAT. W 4-7 Fis.
| o .“-:s =R

K 4-7 &Ik

4.6.4. 26 N\ (step into)

BODIRR, WRIER R BORH, WS RENE. WK 4-8 Fix.

| Ok @“Zv -

K 4-8 AN

-9.
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4.6.5. 3 (step over)
FUDR, BB KA, HHM— %N C ), EEAT, Aail
NBREN . sl 4-9 FioR.
| o> 0 ® m-u»l

Kl 4-9 it
4.6.6.3 [B] (step return)
M B el T, HRRBOHME (caller) 4b. U1K 4-10 Fror.
> o m 2 2]

4-10 iR [A|

4.7. W

" R R AR R P AT IR TP E I NMRR AL B, T EHE R AT, DUE
FEF 3] DU R e (RS - AR R MMEASAT B . HRE P AT BT AL BN, FEfr =
fE AT, BEANR BRI, AR, R AT DUZAT HAT AU, WA RN,
A AR R, DASGEAT o A o BT A, RERP AT BLZ D ER AR I (R
TR, MEARERE AL, FIWrRE e 28R & 1L, R PR R IF AT 2
2o W2 Wl EZE TR, T2 AR R s R AR w7 B

f£ CodeCanvas 1, Wi AR EE ORI EN S, BRI ZEH W, MHERWT

4

4.7.1. BIEEWT =

eGSR, AT 5 R ATE i B B S, SN RS, diERdsEm AL E
BRI G R bR, WA 4-11 Fros.
3=int add(int x, int y){
4 int ret = x + y;
5 return ret;
7

¥

4-51 GBI WT &
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472 )3 NS

TEWT 5 (Breakpoints)fL B, JERFTE B . BOAEHLT, $TH Debug EMKE S,
Wr AL AR A O JE s, IR, AT RLETY SEF => Windows => Show View =>
Breakpoints i o 13 2) 00 B 2) 328 I s w8 A AT DUS Y BREE IR 0T 5.
K] 4-12 JIR
(= Variables | ®s Breakpoints 2 |9¢ Expressions =i Modules
XREA|BES
& [function: _exit] [type: Temporary]

[ ] @ [function: main] [type: Temporary]
2 main.c [line: 5]

Kl 4-12 )5 FH /2% F

4.7.3. BHI B BT M=

TE W AL A, e R B R W S, s TR B 5 B BR (Remove Selected
Breakpoint), B A]#H BAH MW £ . B0 7R w28 Hh X W AL B AT 5, R n] CABIRR W

EW S AL, S TR X5 1 EFR(Remove All Breakpoints) B A il Bk fr &
B AT R

8. AN

AL IR IE T CodeCanvas il iAFE 7R 7 OCBIER . & R T Rt 17—
P EHMEE R PAT AR R O E B A . kA, AR AT DA
BELEIE. WA, NPT FRE RS, s Bhe A g2 7 3 15 R

i BV ] S AR T AR L] . RIS R EE] . R A WA
A AN 27 A7 2 A0 ] 55 o 75 Debug iZALIE T, AT BLEIE 32542 => Windows => Show View
A H P R A
4.8.1. A FHERALE

TR T B e e B P AR AE 2 . TR TR — i s ek B0 5% 2 0 208
g5y, R IBEARE P AT SR 10 el A P AR (e ARG R T, i A T A AR
B, RERE SAT RA T 2 AR P AT U R L DR R R R A R SO Y
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L main eREOAM] add sRECABI, AR W 4-13 s, b TANE I AL,
FERLIE R AL R 07 o HABAL BRI s Z A AR e sl 80 B R 3B B, il =
T L) R, T A SR AL P PR JR s A5 JE 0T L 24 i i ) e

%# Debug 2 |5 Project Explorer | k| g = O
v I test Debug [Application with GDB and OpenOCD]
v i testelf
~ of* Thread #1 (Suspended : Step)
= add() at main.c:4 0x106e08
= main() at main.c:11 0x106e54
s Ci/MyStuff/work/FOMTEK IDE/release/230831/riscv/gnu:
». OpenOCD Process

4-13 FRALIE

4.8.2. x4 (Disassembly) L&

SO AT R R I g Ta 4. B EE IR, F27 5 n] DL T fFE 7
REPAT RS, B AR P (8 dE A M e

WKl 4-14 frox, RO FZaH LU LA 7

L B A i A P M R A O, 7 R B 1 LR
&

2. LgRR 2 BRI TE 2 WoR N IATE, RoRBEF gD &

3. FF5 A RR: WA ISR N T AR S (s REA), N
B B PT BE 2 BoR 7 5 240K, 7 (ERE e A iE & PTAE R R 30

4. YESTAHAS B FRic A0V g AR Fioss B IR SC A N 2, J7 AR 7 D3 B 4 il R
¥ 1) Thfe

A W e T —F MLy L g

4 int ret = x + y;
» PA106e08: 1w af,-12(s8)
Pe106edcC: 1w al,-16(s8)
Pe106eld: add af,ad,al
Pe106e14: SW ap,-20(s8)
5 return ret;
Pe106el8: 1w af,-20(s0)
Pe106elc: 1w ra,28(sp)
Be106e20: 1w 50, 24(sp)

Pe106e24: addi sp,sp,32
B0106e28: ret

4-14 ICZmE
212 -
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B Gt A0 1 1 T A 0, 5 — S P ) R 05 {5 FH Y SE A A SO gm AR SS D RE,
Kl 4-15 FivR .

1. HhEBEHE: AR SCORRE R A )5 ek e 425, ] DU R Rs g sk i JIC 4 15 2

2. JRIEYRTALE: 7ER P EE HA A B RICHE S5, A Home TH, 7TRMER
T A L PUTE [e] 3R PP S s AT A B

3. BEHRUE SR VIR 75 B SIS A I rh R AR VR S A

R L

|Enter location here || &1 & S/&| £F 2 8
K 4-15 Al g ML e T2 5%

4.8.3.Z% & (Variables) LK

ZEAME T SRR &R ER Y HME. WA B, R o A] DUSE
W, EEMSEARRERE, FIRERMRERF RS, K 4-16, £ ERE Y, &
ZNYSNEISE

1. R BNREAEZENET UILAIRE R, TR R IR AR,

2. WERA. BEMEIC B R NERENBRENY, Bl 7R BHE.

3. A BEMEERENMEER A E. XEETDRES. F A8 7R/
H S SR T ) SR B

WERA BB AR HE, 7T RL AR R AR AR, A A\ BTE 5 R 18] 42 RITAT 58 B
X AR EAH E L.

ﬁ%ﬁ¢§%ﬂ%@%%ﬁ%ﬁ%§%ﬁoﬁ%lﬁ%igﬁﬁpﬂu@ﬂﬁﬁ
JE TR I BRI RIS B2 SR 1 A1 J= 77 2

=

= Variables 2 | ® Breakpoints % Expressions| = Modules| 2 Disassembly -
HE| e g
Name Type Value
= % int 1
=y int 3
- ret int 4
Name : vy
Details:3
Default:3
Decimal:3
Hex:0x3
Binary:11
Octal:03

& 4-16 ZAEME
-13 -



IDE T FH FDM320RV335

4.8.4. FiEFH, (expression) FLHE

Tk AL A TPl AL IS LR A U . @ RaA A, #1277 A nT DL AR
FREE IR, RN EE R NE, T BRI A2 PR o BT 3 AT
AR E A NMEIEE A, R4 7 RN B e

FKIEAMEE 4-17 Pow, B8 =51, 5FEMEEL, saleRia, K8, E.

it ST Add new expression ISR IARN, REATURTE, HE. H¥is
HOREORA . FARSNAE, WMATHEYE, iR AT RREENER, £R
R WE K AR, PO SRR

R A BB NERE X ME, RFE A E R IE R, A8 et Bl 4, RIS
FERON FRIE AE B R, W ARECHE F IR E TR B SUE.

SASEPERARL, s TR R T AL T LS SO R B R UK 2RI
i R 77 3

EE | % %| Yot 8

Expression Type Value
0= X+3 int 5
* $ra void (*)() 0x106e60 <main+40=>

9= SysCtrIRegs.PLLSTS.bit. MCLKSTS Uint16 0
%= Add new expression

4-17 Fik XA
4.85. W (memory) FLHE

A E L B T R N R AR SRR 2 6 A A 47 T B . i 4-18 s,
A7 B A S — 2 P9 A7 M L3S (Moniitor) 2R o AN AR B #0ARR el HAL B (BN 2kt
Bl $8E A AERR S o B A7 M R B8 AT LSRR R T OB s 2K (A7 25)
e VAR SRR TR SRR, BIFoNHER] (BR2). ASCIL. B S8E. /5558
BRI+ Nk A Al LSS, ¥ B 3 R B R

S5 /M Monitors 35 (4% €0 11 5 % 7T LT — AN P 77 A ML 8, 70 Hh e E o
U

NN AL, Sl OK e BV R — A A I AL U R WA 28
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Gt B[S % - 8
Meonitors <= % % 0x10000 : 0x10000 <Hex> 2 . 2= New Renderings...
@ 0x106e18 Address 8- 32 4 -7 8 -8B C-F ~
¢ 0x10000 eeooooo0000leeeo [JELEEELLEN E£C020100 54030100 BCA30100

0000000000010010 000PORR0  PORERERE  0OD0RE0E  AEEEEPE0
0000000000010020 00000000 ©0POEE0E  OOOOO0OE  PEEEBERO
00PO0ORORAA10B30 000NORED  BREAEEED  PABEREEO  PEEEEEEO
000000RERRR1IERA0 0EPPEERE  POPERERE  0OD00E0E  PEPEEEE0
0000000000010050 00000000 ©0POER0E  0OOOOE0E  PEEOBEOO
00PO0PNORAA1ABED 000NONED  PREAEAED  PABEREEO  PEEEEEEO
000000RERER1IER70 0EPPEERE  POPERERE  0OD00EGE  PEPEEEE0
0000000000010080 00000000  OOPOEE0D  0OPODOEE  POOODORO
000000NORAR1AA00 000N0NOD  ODOEE0D  PEEOREOO  PEEEEEEO
0000RRRERRR1IERAG 00PPEERE  PORPRERE 01000000  0OPEOEE0
00000000000100B0 ©OE33CDAB  34126DE6  ECDE@S00  ©BOOOOOO
000E0PRERRR1AACH 000DODOD  DOPEEDOD  PEBEREOD  PEEEREOO
0000GRRERRR1IERDE  0APPEERE  PORPRERE  0ROORRGE  PEPEEEE0
00000000000100EY 00000000 ©00ECA0E  0OOE0E0E  POEODOOO
00000000RRR10RFE 00PPEEEO  POGRRERE  0O00RR0E  AEEEEPE0

nnnnnnnnnnn 10100 Y eXetelsYetets) AARAARAOO Ve tateteletsts) ARALOAOO0

4-18 WHMHE

s EJ7 ) New Renderings 7 PAge 438 @ 7 HLAtAS U N A7 3008« A&l 4-19 Fir
N, PR TR AS UG A Add Rendering(s)¥% 4 BI A] 8 I8 ) 7 2K

_ T
Monitors 35 % % [0x10000 <Hex> 57 New Renderings... - |
¢ 0x106e18 | iMemory Monitor: 0x10000 : 0x10000
R B000 Select rendering(s) to create:
Add Rendering(s)

ASCI

Signed Integer
Unsigned Integer
Hex Integer

4-19 Huig X

ENAAALE R s B, nTCAsR bR S, Hodr, TR Format 1% A 17
FATHPE EM A, 1HIT Add Watchpoint(C/C++)R] LN TE & WAL B I EE 15

4.8.6. F 2% (register) #1HE

A AL E R TR R R BN A A4t . R P,
RN AT A B CPU Bioh e b A7 o S AT e . I &R A48 e, Tk
N AT T R AT S ADIRES, B ENE . RE0H RS H0R BHESE .

WA AL U 4-20 Ps . 3R =51, WARE a2 (A aedlAs, T ARAIEA),
WAL SEATAE S, sl i A 4745 AT AR R 5 Fos 22 Mk S A AR AR ALK 5 A7
SRR O SARE. WIREBMCE AR NME, W LR N A A A E, SBAETE, m
o7 9] 4 RIVAT 5€ 0t a5 A7 2 E A2 2L
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A AR S, et TR b © BRI, T DA OB R R R
AL B A =5 2

Name Value Description
i CAP4 0x0 [0x0000d414]Capture 4 ...
i ECCTL 0x0 [0x0000d428]Capture C...
it ECCTL2 0x6 [0x0000d42a]Capture C...
I ECEINT 0x0 [0x0000d42c]Capture In...

v il ECFLG 0x0 [0x0000d42e]Capture In...
HINT 0x0 [0,0]Global Interrupt Sta...
i CEVT1 0x0 [1,1]Capture Event 1 Sta...
i CEVT2 0x0 [2,2]Capture Event 2 Sta...
it CEVT3 0x0 [3,3]Capture Event 3 Sta...
i CEVT4 0x0 [4,4]Capture Event 4 Sta...

it CTROVF 0x0 [5,5]Counter Overflow S...
it CTR_PRD 0x0 [6,6]Counter Equal Perio...
it CTR_CMP 0x0 [7,7]1Compare Equal Co...
it ECCLR 0x0 [0x0000d430]Capture In...
iiti ECFRC 0x0 [0x0000d432]Capture In...
54 eCAP2

Ht eCAP3

AL A ADA

4-20 FALEAE
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5. A4

5.1. ZmiE58 (editor)

RN G ml Lld e e TAEN AL B, Xty H AR SO, 24 & 2 o H AR
PR, RN AT BLEE RO SO EAT g, Wl 5-1,

5 Project Explorer &3 = 0 || [g mainc 2
= <‘£.=|) T 8 1 #include "RV335_Project.h” /! Dew

-
2
3

475 RV335demo
=§ff Binaries

#define PI 3.14
int num = 1;

> [l Includes
42 sre
» = include
s = source
> [€] main.c
o [ system
» (&= Debug

= int main{void)
i

// Initialize trap
trap_init();
init_priority();
f/ Initialize System Control
InitSysCtrl();
/* --- add your code below ---*/

=
CO~J W B W= @WK~ g u

return @;

f

K 5-1 gwiEds

5.1.1. P4k

MR LI “Window”, P85 FE“Preferences”, 7554 H FXTHAE 22 M 51 % A,
WKL FE“General”. “ Appearance”. “Colors and Fonts”, F-{EAMIKIFIFRF, MKIGESF
“Basic”. “Text Font”, )5 sidi A MAY“Edit... " 4%4, k&l 5-2.

EX Preferences o || = | 2|

type filter text Colors and Fonts

4 General Colors and Fonts (font, size, type, ? = any character, * = any string) :
4 Appearance "‘

type filter text

Colors and Fonts P

i
4
4

oo

Label Decorations B Newest revision background color
Compare/Patch _| Oldest revision background color
Content Types B Qualifier information color Use System Font
» Editors Bl Range infﬂicator color ea—
Globalization g Text Editor Block 5e on Font
. Y Edit Default...
Link Handlers > g C/CH++

K 5-2 7k

TEH S AT DA AR . IR A NAT R B, ] 5-3, fJa i 52 AN A
1 Apply #2411 K N A 24

17 -
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FDM320RV333

512475

=5 =]

FHE(P):

Consolas

FURE):
]

Microsoft JhengHei UI[]
Microsoft YaHei UL

MS Outlock
MS Reference Specialt -

AaBbYyZz

BEIER):
BRISS -

5-3 WHE

M S AL IE T Window”, PR 5 1k “Preferences™, 1E 5 H X T AE A=A 51 2%
IR IEFE“General”. “Editors”. “Text Editors”, RGEAMECE TG, A%k “Show line

numbers” W /R 175, RZMAERITS, & 5-4 ME 5-5 pos. &a sd BT H)

“Apply and Close 44 W FZ 24 -

B Preferences

type filter text

File Associations
4 Text Editors
Accessibility
Annctations

Globalization

Text Editors

4 General * | Some editors may not honor all of these settings.
» Appearance
Compare/Patch See 'Colors and Fonts' to configure the font,
Content Types
4 Editors Unde history size:
Autosave

Displayed tab width:
["lInsert spaces for tabs

Remove multiple spaces on backspace/delete
[¥] Highlight current line

Hyperlinking [l Show print margin

Linked Mode |,

Quick Diff Ol G e e s
spelling

[¥] Shaw line numbers

Show cursor position in the status line

80

Enrich after delay

1

Keys
Link Handlers Show selection size in the status line
Perspectives [7] Show range indicator
Search [[] Show whitespace characters (configure visibility
> Startup and Shutdow [¥] Show affordance in hover on how to make it sticky
Tracing When mouse moved into hover:
» Workspace
 C/Chs [7] Enable drag and drop of text
. Help [7| Warn before editing a derived file
s Java Smart caret positioning at line start and end
> Maven - | Show code minings for problem annatations:
ol i »
N
@ b

[Apply and Close | |

Cancel

I

K 5-4 fTESRE
5.1.3. 55
A S BALIE T “Window”, R J5 1 $ Preferences™, 1E 5 Hi B X EHE A 1) 58

- 18 -

=
[ I v I W T v« B B Ty R W I

(o IV R - W¥)

18

it main.c &2

#include "RV335_Project.h

#define
int num =

PI 3.14
1;

int main(void)
i
J/ Initialize trap
trap_init();
init _priority();
// Initialize System
InitSysCtrl();
/* --- add your code

return @;

B 55475 E
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R IRE R “General”, “Editors” “Text Editors”, &5 7E4 MIEC & Wi, #£2]“Appearance
color options™ %13, 7E%FK HhikH“Background color”, #RJ5 sitiAi N “Color: 551
A T B, WK 5-6, ffE T N7 “Apply and Close %4 B FHAZ 2

B »references = o e
type filter text Text Editors [ v 8
4 General + | |¥|5how attordance in hover on how to make it sticky N

» Appearance e s w17 s T T A =
Compare/Patch
Contert Types Enable drag and drop of text
4 Editors [¥] Warn before editing a derived file
Autosave Smart caret positioning at line start and end
File Associations Show code minings for problem annotations: None
4 Text Editors
Accessibility gl
Annotations X
. Appearance color options:
Hyperlinking
Linked Mode ELine number foreground Cu\or:-l
Quick Diff 3 Ocurrent line highlight System Default
Spelling OPrint margin
Globalization OFind scope
Keys Oselection foreground calor
Link Handlers M selection background color
Perspectives DBackground color |
Search MFforeground color =
. Startup and Shutdow WHyperlink
Tracing
> Workspace
s CfC++
. Help « i B
. Java More colors can be configured on the 'Colors and Fonts' preference page.
: Maven
> Run/Debug Restore Defaults Apply
a- i G d w b
‘/7) |(\_A‘ 124 IApp\y and Closa] [ Cancel l

5-6 HRKE
5.1.4. FHZEH
A S AR T Window”, PR 5 1L “Preferences™, 1E 5 H X T AE AN 51 2%
IR 3% £ “General” . “ Editors”. “ Text Editors”, %R )5 7E A MEE i, /2)i%k“Show

whitespace characters” Il \B7x 2= 7245 (WE 5-7), RZWAER, &fEAEHEFTH
“Apply and Close &£l W &%, 4niEl 5-8.

[g] main.c £3
1 #include- "RV335_Project.h" [/ -Device
2
3 #define PI-3.14
4 dint-num-=-1;
5
6= int main(void)
8 //-Initialize trap
9 trap_init();
18 init_priority();
11 // Initialize System Control
12 InitSysCtrl();
13 /*-----add-your code -below- ---*/
14
15
16 return-8;
17 }
18

K 57 FEER
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B Preferences - o=
white *® Text Editers =14 - 8
4 General [PT—— -~ N
Compare/Patch [T]Insert spaces for tabs
4 Editors Remove multiple spaces on backspace/delete
Text Editors Highlight curren t line
4C/Crr [7] Show print margin
4 Editor
. 80
Save Actions
4 Java Allow editors to override the margin column
4 Code Style Show line numbers
Formatter Show cursor position in the status line
a4 Team Show selection size in the status line
Git Show range indicator E
Show whitespace characters (configure visibil;
Show affordance in hover on how to make it sticky
When mouse moved into hover: Enrich after delay ~
Enable drag and drop of text
[¥] Warn before editing a derived file
Smart caret positioning at line start and end
Show code minings for problem annotations: None
100
Appearance color options:
HlLine number foreground Color: [ ]
OCurrent line highlight [ System Default
DOPrint margin N 2
« m 3
@ Dy 4 [Apply and Close ||| cancel

5-8 THFHF

5.2. EME (Perspective)

Eclipse (&ML ESE Mt 17— M R g 077 ARH L ME B TAE A,  DUENASF I FF
RARSS A TARRAR . M B € SGEML AL . THEMPEERE, 7] DU ST KRR IF
PRSI B FH P AR .

EEITE eclipse B4 _FMAEAR, FFAN IR DL I m o 1 e 7 40 1] B ke S B 02
P, il 5-9, dn] DA 22 ) = EbR, 78 3HE g e HARE LA

= <

[ || % c/c++ (35 Debug]
PEE et § = O

K 5-9 FEE

53. JFRAHE
5.3.1. TFEXM Y2 (project explorer)
TERN AT DLAE T AR S 288 h B TR A TR N B9 SO, mT LS ST IR s I

B MR, By SHAE, WCRF ctrl + ¢ FISCHREHIR ctrl + v 1ISCIRE L S g
o

-20 -
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W s EAR CnE 5-100, JF)E At T SCHE DRE A P K B Bl E AL .

File Edit Source Refactor MNawigate Search Project Ru
Awil B -/ -Emi DR it
{5 Project Explorer &3 = <\="=.; 7 8 = 0O
AI_,-_—'} RV335demo
=§:;b' Binaries
* [npll Includes
a3 src
> (= include
» = source
| [ main.c
o (2 system
> = Debug

Kl 5-10 A

5.3.2. K4 (outline) L&

FEITIF C XA, A M KRAILE T, 2 BoR TS F e R 2RACE .
PREL PR Gl S KL R e, LPRECEN BIe R AL E, Wl 5-11,

[£] main.c &2 = O ||B= Qutline 22 | @ Build Targe
1 #include "RV335_Project.h” // Dev 2l RV335_Projecth
3 #define PI 3.14 # Pl :
& num:int

4 imt num = 1;

@ main(void) : int
6= int main(wvoid)

a8 '/ Initialize trap

9 trap_init();

L2} init_priority();

11 // Initialize System Control

12 InitSysCtrl();

13 /* --- add your code below ---*/
15

16 return 8;

K o5-11 KK
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6. T2RRV ##H T E

TR2RV ¥ THH T TI “FEH C R4 FDM320RV335 AT LS AT #I4R

i, HETSCA T, USRS B PR AHS (R e o
6.1. HRZH

TI2RV 1 HREMWE 6-1 iR, LAY SO, H:
rules.txt Sy AR A
2. ti2rvjar NIRRT jar .
3. ti2rvjat.bat X ti2rv.jar (M3 %6,
4. ti2rv-all.bat NHEEFARNA, 20207 H U7 HX T A C Ui T .

5. AU EH xlsx $Et TIZRV B H M AU BAESR S rules.txt If 275,

=

| rules.txt

\=2 ti2rv.jar
ti2rv-all.bat
ti2rvjar.bat
M58 xlsx

K 6-1 HatE5H

6.2. 1 UHA

1. 5 rules.txt FeHpi o BRI SCHE B — 2088 22 1R3-S0 A 78 48 A 0 B 20 1R,
AEFRYL YIRS RSO EAT b, A A LT A
a) op: BRAERM. 40 del(MFR), add(Hi), rpl (8 #)55
b) obj: PATHIE . 40 glbl_var(2/RAE &), func_del(B%H ), blck_sntn(B )5
c) times: PUATHAEIIREL. BHE once(H AL S —IRILEL I A 2%), infi( TCFRIK).
d) pat: ULECHELG A2, CRFIENIRER.
e) to: X T EHIRME, EEHENMNE.

VEAMRUNE I, 27 HUU B xIsx A% SCAF

2. BATHARAEFE, ALK H BAS Ay 2

_22-
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® ti2rvjar -v -c <EALE [ JE A SCAF> o <RI SCAF> -t <A A
® ELIZAT ti2rv-allbat AR, HENEFX AT H TIA C AT, #
RN S EAE Y =80 H 3% N 1Y rules.txto

-23-
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/. Flash
IDE $248t Flash M3 0E, AFGHMR . Ko, BOUE LA 22 A UM S R 2

7.1. Flash #/EAO

IDE #2&fit 7 P Flash #/EMIA L, 2 5I7ER 4= => Tools => On-Chip Flash Fll
Debug Configuration H1f#] On-Chip Flash Fr25 00 . PIFR A LTI IG5 S N 2522 —FERY.
4R 23833 Debug Configuration F1F (1 TUTH, AEIZ1TIN 2 HZIIRHEE Flash 5[t
AT FATC B ) Flash #E47 4 N A4

7.2. NP E

A 7-1, %A\ OSCCLK, #£# CLKINDIV Al PLLCR Value J&, it configure f%
Hl, PSR LSRN SR ECE, B )G, 25 Config Clock Success $E7R %] THAE.

Clock Configuration
OSCCLK(MHz2): |30 |

CLKINDIV: 2 ~
PLLCR Value: |10 v
configure

K 7-1 e E

7.3. Flash #/Ei%E

Ul 7-2, 3@k Debug Configuration 7 Flash FL[H, AT LLIEHF Flash #EAER 51,
5374 Erase, Program, Verify (Jo#5%, FERER, BJG%IIE); Program, Verify(Jtkes 5 5
iF); Load RAM Only(A#EATAEAT Flash A 5<#4F); Verify Only({¥ 4T % 1IE).

FEIX HLHHAT OO B £ 55 T B 10 flash ELAHRAE A 45 Grtsk, FERIVeE7EREAT
Debug 5 Run I 414 %) flash #4T #24F.

Flash Program Setting:
® Erase, Program, Verify
O Program, Verify

O Load RAM Only

O Verify Only

72 BAERCE
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7.4, B

Wi 7-3 Fi7x, {E Erase Flash [X38(A] LA#EER flash Joi [X, “A)3% BRI e X 5 Mt
Erase Flash #2411 J5 f 25 B al B2 Bk 48 72 1 50 X, #2800 G 25 success X THAE.

Erase Flash

Erase Sectors Selection:
Sector A:(0x670000 - 67ffff)
Sector B:(0x660000 - 66ffff)
Sector C:(0x650000 - 65ffff)
Sector D:(0x640000 - 64ffff)
Sector E:(0x630000 - 63ffff)
Sector F:(0x620000 - 62ffff)
Sector G:(0x610000 - 611fff)
Sector H:(0x600000 - 60ffff)

Erase Flash
P 7-3 2R

75. RFE5HAE

W 7-4 Fios, MR DX flash AT Rk MERAE. I select &AL IR,
BRIt 285 v LU Program Flash #HT RSk Bl Verify 42411347 56
WE. SR EERIAR T2 elf UM, MIETHRIHES bes k.

Select Program:

Select Program: Select
Program Address:

Program Flash Verify

7-4 e 5 5k

7.6. BEBHAF

WP 7-5 FizR, #E Code Security H A LAX} Flash Z24-islikfT#4E. £ EAURE,

AT LAAE keys HIA S U H#00)5, #id Program Password 24 15 BHT 50, % B %6

FAEZJJL@&, W AT LLEIS Lock #Z81 T3 8. 72 AR, Al LAE keys FHIHE 4T
0 J5 8L Unlock HEAT AR R 1E

_25-
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Code Security
Key 0:

Key 1:

Key 2:

Key 3:

Key 5:

Key 6:

| |
| |
| |
| |
Key 4: | |
| |
| |
| |

Key 7:

Program Password | Lock | Unlock
Kl 7-5 24
7.7. SRR
WK 7-6 s, BCE GPIO 5|5, it Start Frequency Test #4411, Bl Al k4T 4
It

Frequency Test
Pin: GPIO_0 v

Start Frequency Test
K 7-6 A

7.8. REGFI

P 7-7, i Calculate Checksum #%4H, B nJ7E i SCAHEH 2E % Flash F1 OTP
% B RS AN

Checksum:

Flash Checksum | |

OTP Checksum: | |

Calculate Checksum
7-7 RS AN
7.9. Flash Boot

PR E G, WRAEESE Flash b, JFHBCR EREH A PATH PR, &%
4 IDE LFEFEHH system SCHFEJE T fdm start.s A1 link riscv.ld P9 SCHEH fdm start.s flash A

link riscv.ld_flash 705l & #edw, B sei)G, EHg AR T IR E flash HRITA].

-26-
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8. Kb T H

8.1. Elf2bin

Elf2bin T HH FKf elf SCAFEFE 4 boot 4 H bin #% 23044, 17+ L E A O 7E IDE
SEHRS => Tools => EIf2Bin Tool. ¥TJF)5 A& 8-1 Ak,

||
Select Program:  C:\Users\GuoYun\Desktop\test rel\adc_seq ovd test\Debughadc seq ovd test.elf Select
Select boot type: |can v

Perform Conversion

Name: .data; Type: PROGBITS; Addr: 0x10000; Size: 0x830; Flg: WA

Name: PieCtrlRegsFile; Type: PROGBITS; Addr: 0x10830; Size: 0x34; Flg: WA
Name: PieVectTableFile; Type: PROGBITS; Addr: 0x10864; Size: 0x200; Flg: WA
Name: .sdata; Type: PROGBITS; Addr: 0x10a64; Size: 0x24; Flg: WA

Name: .rodata; Type: PROGBITS; Addr: 0x10a88; Size: 0x300; Flg: A

Name: .eh_frame; Type: PROGBITS; Addr: 0x11000; Size: Ox4; Flg: WA

Name: .text_fdm_start; Type: PROGBITS; Addr: 0x100000; Size: 0x98; Flg: AX
Name: .text; Type: PROGBITS; Addr: 0x100750; Size: 0x5ff2; Flg: AX

Name: .init_array; Type: INIT_ARRAY; Addr: 0x106744; Size: 0x8; Flg: WA
Name: fini_array; Type: FINI_ARRAY; Addr: 0x10674c; Size: 0x4; Flg: WA

---- Succcess ----

Kl 8-1 BT H

B Select AN EREM elf CIF, SRIGIEFE boot [IZRAY, #eE Ml
Perform Conversion %4, B RI7E T 75 SCAKE F 3R B 2 #1125

8.2. EHMK
EFHWA T AH T A IDE 507 /A4 M RrEE LG . TAKAIFE IDE
SRS =>Tools => Test Connection. T )5 At U &l 8-2 flrz. &Gk #4745 A

FEREH RS, 5T RV335, interface £ jlink.cfg, target % 4% sc001.cfg. SR JG i Test
Connection, RJA]7E N [ ) SCAHE H J@ 7~ E B 45

Select Interface: jlink.cfg v
Test Connection

Select Target: sc001.cfg v
Technology Corporation), part: 0x0005, ver: 0x1) 2

Info : [sc001.cpu] datacount=4 progbufsize=8

Warn : [sc001.cpu] Hart doesn't exist.

Warn : [sc001.cpu] Hart is not halted!

Info : [sc001.cpu] Examined RISC-V core; found -1 harts
Info : [sc001.cpu] XLEN=32, misa=0x40801124
[sc001.cpu] Target successfully examined.

Info : starting gdb server for sc001.cpu on 3333

Info : Listening on port 3333 for gdb connections
shutdown command invoked

Test result: success

B 8-2 JEFENA
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9. f¥3% A: Intrinsic
9.1. ERERH

9.1.1. builtin_riscv_asr64

® M

‘int64_t __builtin riscv_asr64(int64 t rsl, int rs2);

® I Ymig4

ASR64 rd, rs1, rs2

® IjRefiid
ZERBUIET 64 LUAF R EARABALEAE, S AT SRR, BAKE
i rs2 f55%E -

o XHUSH

ZH FKA L

rsl int64 t B RS AT BT EHE

rs2 int A K, BUATEH 0~63.
® x[n[fy

ZH) KR Wi B

return val | int64 t B a4 R

9.1.2. _ builtin_riscv_dmac

® A

int64 t  builtin riscv_dmac(int rsl, int rs2, int rs3);

® JL4ifES

DMAC rd, rs1, rs2 [init] [out]

® IfifEdiik
2R MG BETEHE rs1. 1s2 BRI 16bit ISRy, SEATX MRz H .

]
By

N

-28 -
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5 et i BH

rsl int e ZmEHE 1

rs2 int e ZINEHE 2.

rs3 BAZEAE | BUEYEHE 0~3, rs3[0] (FARAL) WH A 1, N2 EE MRO.
MRI1 21748 (AN init FRic). rs3[1JA05E R 1, NIFRRIK
Huafe 2Umas 5 G out F5id).

® R[nl{H

return val | int64 t

WA B S ISR RIS R

9.1.3. _ builtin_riscv_flip
® ¥ Y

‘int __builtin riscv_flip(int rsl);

® I Ymig4

FLIP rd, rs1

® Thftfiid

PR BT IR ASEIIR 16 ALEAT LURF R 14T, mAL R AL

® KNS
ZH et Wi
rsl int WO e Bt
® X[Hl{H
ZH FH i
return val | int IR CER

9.1.4. _ builtin_riscv_get mr

® AR

‘int __builtin riscv_get mr(int imm);

® JL4ifES

MV.X.MR rd, #imm1

® Iifigdiiid

RIIEE w7 A7 4% MR % -
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o XS

ZH KR P

imm A | ARUE0,1}. 0XFR MRO, 1 %R MRI1
® kA

S Ay !

return val | int 852 1798 MR HI%E .

9.1.5. _ builtin_riscv_get mr

® M

‘void __builtin riscv_set mr(int imm, int rsl);

® I Ymig4

MV.MR X #imml, rsl

® Thftfiid

2548 MR JE & A7 A I

o XS
S et i B
imm BAVEEE | ARUE{0,1}. 0 X MRO, 1 %R MRI.
rsl int HrfE
® R[F{H
Tco

9.1.6. _ builtin_riscv_Isl64
® R

‘int64_t __builtin riscv_1s164(int64 t rsl, int rs2);

® JL4ifES

LSL64 rd, rs1, rs2

® Ijfigdiiid
BEAT 64 LR oy A7 ae X A A, AIRAZLL 0 3158, ML KIZH 1s2
JE o

%

1

o

W

%

=
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ZH KA A
rsl int64 t T A DRAC TR
rs2 int WA BN 0~63.
® X[H[{H
ZH Al L
return val | int ML 4R

9.1.7. _ builtin_riscv_Isr64

® M

‘ int64 t builtin riscv_lsr64(int64 t

rsl, int rs2);

® I Ymig4

LSR64 rd, rs1, rs2

® Thftfiid

BEAT 64 LU A A7 e X A RS AL 1R AT,

EALLL 0 TR, FEALKE H rs2

fRIE .
o XS
ZH eyt Ui ]
sl int64 t X ADRAET
rs2 int AL 0~63.
® x[n[fy
ZH eSS Ui A
return val | int (E VAR
9.1.8. _ builtin_riscv_max
o A
‘ int  builtin riscv max(int rsl, int rs2);

® I Ymig4

MAX rd, rsl1, rs2

® Thntfiid

R LB T 5

-31 -
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o XS
ZH HH i B
sl int BR5HE 1
rs2 int R 582
® x[n[ff
ZH et i B
return val | int PN 0 R R
9.1.9. _ builtin_riscv_min
® xHE MY
‘int __builtin riscv min(int rsl, int rs2);
® I Zmin4
MIN rd, rs1, rs2
® Ijfediik
R A LA 775 5, R IR EUNE .
o XS
ZH eyt 1t B
rsl int HRSEE
rs2 int BHR5HE 2
® x[nlff
ZH eyt Ui B
return val int PN R N
9.1.10. _ builtin_riscv_mpya
® REJFE
‘int __builtin riscv_mpya(int rsl, int rs2, int imm);

® JL4ifES

MPYA rd, rs1, rs2 [init] [out]

® Ijfigdiiid

2R EOEAT AT R RIS
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o XU

S8 Al ]

rsl int Fe 2 MSH 1

rs2 int BN 2

imm BHCPEE | BUATEE 0~3, rs3[0] RIKAL) Wiy 1, N2> E & MRO
(M T init R0 . rs3[1]ATEN 1, MFRIRIREN IR 2 ng
B CENT out Arid).

® ix[n[{H

S8 Al i

return val | int AL S g B g . ERINEE R, rS3[1)FRE R E N
1, BIEIN out bRic.

0.1.11. builtin_riscv_mpys

® RHAA

‘int __builtin riscv_mpys(int rsl, int rs2, int imm);

® I Ymig4

MPYS rd, rs1, rs2 [init] [out]

® Thftfiid

2R B EAT I AT 3R RIS 5

o WHZH

ZH St Wi B

rsl int Fe RIS 1

rs2 int e Rk S5 2

imm BT | BUEYERE 0~3, rs3[0] (HARAD N 1, NLHEE MRO
CEANT init A1) rs3[11A05FR )9 1, MR RIRIGR R N4
B CENT out brid)o.

® x[n{H

ZH FA Tt

return val | int TR J5 3R SR 4 . BRI R rs3[1]HRE R E N
1, BIESHD out ARic .

9.1.12.  builtin_riscv_qmpya

® AR
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‘int __builtin riscv_gmpya(int rsl, int rs2, int imm);

® I Ymig4

QMPYA rd, rs1, rs2 [init] [out]

® Iifigfhiid

PR BT IAT AR R INB S, Hh sk 4 R IBUR R 1 5y 32bit .

® KIS
ZH FA L]
rsl int FeRZIMSH1
rs2 int e ZIMSH 2
imm BRI | BUEYERE 0~3, rs3[0] (HRARAD) N 1, NLHEE MRO
CEM T init 510D rs3[1JE15R A 1, WK RN
R EEMT out Frid)o
® x[AfH
ZH FA i
return val | int TOAALEE J5 3R M EE . EERINAE R, r3[1]FEREN
1, BIESHN out A7ic .

9.1.13.__ builtin_riscv_qmpys
® RHUAA

‘int __builtin riscv_gmpys(int rsl, int rs2, int imm);

® JL4ifES

QMPYS rd, rs1, rs2 [init] [out]

® Iifigfiliid

2R BT AT B Rplia 5, Hh sk g R BURA R 32bit.

28 R Tt B
rsl int e RIS 1
rs2 int e RN SHL 2
imm BRI | BUETEE 0~3, rs3[0] (FRARAD) WA 1, M2EE MRO
CEMT init #3108 rs3[1]WHRN 1, WL RIKIR R n4s
B ENT out 198D
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S8 it i 1
return val | int TRNAL PR 5 ofe Bt . BRINAE AL, rs3[1 TR B BN

1, RSN out F5ic.

0.1.14. builtin_riscv_restore

® M

‘void __builtin riscv_restore();

® I Ymig4

RESTORE

o Thfediik
ZBRHPGE M shadow 75 17 a MNEF JEAY 27 4745, J&_ builtin_riscv_save()
BRI T R
o XK
o
® X[Hl{H
T

9.1.15.  builtin_riscv_save

® RHUAA

‘void __builtin riscv_save ();

® JL4ifES

SAVE

® itk
12 BR B A 27 A7 A ARA7 B shadow 717 4% . X X AEAT A% (s LB
RIS X F 2 A7 2R OR 7, e CSR AR 8 AT IR
o KHSH
Teo
® R[HfH
T
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9.1.16.  builtin_riscv_rol

® M

‘int __builtin riscv_rol(int rsl, int rs2);

® I Ymig4

ROL rd, rs1, rs2

® Ihfgithiik
BRI rs1 AT IR LR 1, B K rs2 45 5E .
o XS

ZH KA ]

rsl int KR A RS B

rs2 int FERALEL, A RUEVEH] 0~31.
® X[H[{H

24 eyt YL

return val | int IR E RS 5 (B0 .

9.1.17. _ builtin_riscv_ror

® A

‘int __builtin riscv_ror(int rsl, int rs2);

® I Ymig4

ROR rd, rs1, rs2

® Ihftfiid
PRACN 11 BEATEIA A AL ERAE, REALI L rs2 $R5E
o XU

ZH et Tt

rsl int KW EIA AR ET

rs2 int G, A RUETER 0~31.
® k[nfH

5 et i

return val int TEI A o B
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9.1.18. builtin_riscv_sadd

® M

‘int __builtin riscv_sadd(int rsl, int rs2);

® I Ymig4

SADD rd, rsl, rs2

® Thftfiid

PR EICRE AN 17 S B R A N, A R AT AL B

o X
ZH Byt T A
rsl int MInz%1
rs2 int M=% 2
® R[E{H
ZH Byt Al
return val | int TN AL PR S5 AR D 45

9.1.19. builtin_riscv_ssub

® A

‘int __builtin riscv_ssub(int rsl, int rs2);

4t 4

SSUB rd, rsl, rs2

® Ihftfiid

PREICRE AN 15 5 BORE R MR AR R, 45 R AN AR 2

o XM
ZH KM Wi B
sl int HIRSE 1
rs2 int MRS E 2
® R[u{H
ZH e~y Al
return val | int TN AL PR 5 A AR R 4G SR .
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9.2. BAEFREE

9.2.1.  builtin_riscv_fracf32

PR A

‘float __builtin riscv fracf32(float rsl);

{BE TR RS

FRACF32 rd, rsl

ThRe ik

AR BT i ) /N

ZH KA Wi

rsl float Tl
A EIL(EN

ZH gt Ui

return val | float INEER 5 o
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